
Best practices for making 

PowerPoint presentations accessible 

The following table includes key best practices for creating PowerPoint 

presentations that are accessible to people with disabilities. 

What to fix How to find it Why fix it How to fix 

it 

Include 

alternative text 

with all visuals. 

To find missing 

alternative text, use 

the Accessibility 

Checker. 

Alternative text 

helps people 

who can’t see 

the screen to 

understand 

what’s important 

in images and 

other visuals. 

Add alt text 

to visuals  

Make sure slide 

contents can be 

read in the order 

that you intend. 

Use the Accessibility 

Checker to find slides 

that have possible 

problems with reading 

order. 

Try navigating your 

slides with a screen 

reader. 

A screen reader 

reads the 

elements of a 

slide in the 

order they were 

added to the 

slide, which 

might be very 

different from 

the order in 

which things 

appear. 

Set the 

reading 

order of 

slide 

contents 

Use built-in 

slide 

designs for 

inclusive 

reading 

order, 

colors, and 

more 

Add meaningful 

and 

accurate hyperlin

k text and 

ScreenTips. 

To determine whether 

hyperlink text makes 

sense as standalone 

information, visually 

scan the slides in your 

presentation. 

People who use 

screen readers 

sometimes scan 

a list of links. 

Tip: You can also add 

ScreenTips that appear when 

your cursor hovers over text 

or images that include a 

hyperlink. 

Create 

accessible 

hyperlink 

text and 

add 

ScreenTips  

Ensure that color 

is not the only 

Select Start > Settings 

> Accessibility > Color 

People who are 

blind, have low 

Use an 

accessible 
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What to fix How to find it Why fix it How to fix 

it 

means of 

conveying 

information. 

filters. Turn on 

the Color filter switch, 

and then 

select Grayscale. Visual

ly scan each slide in 

your presentation for 

instances of color-

coding. 

vision, or are 

colorblind might 

miss out on the 

meaning 

conveyed by 

particular colors. 

presentatio

n template 

Use built-in 

slide 

designs for 

inclusive 

reading 

order, 

colors, and 

more 

Use sufficient 

contrast for text 

and background 

colors. 

To find insufficient 

color contrast, use 

the Accessibility 

Checker. 

You can also look for 

text in your 

presentation that’s hard 

to read or to 

distinguish from the 

background. 

Strong contrast 

between text 

and background 

makes it easier 

for people with 

low vision or 

colorblindness 

to see and use 

the content. 

Use 

accessible 

font color 

Use built-in 

slide 

designs for 

inclusive 

reading 

order, 

colors, and 

more 

Give every slide a 

unique title. 

To find slides that do 

not have titles, use 

the Accessibility 

Checker. 

People who are 

blind, have low 

vision, or have a 

reading 

disability rely on 

slide titles to 

navigate. For 

example, by 

skimming or 

using a screen 

reader, they can 

quickly scan 

through a list of 

slide titles and 

go right to the 

slide they want. 

Give every 

slide a title 

Hide a slide 

title 
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it 

If you must use 

tables, create a 

simple table 

structure for data 

only, and specify 

column header 

information. 

To ensure that tables 

don't contain split cells, 

merged cells, or nested 

tables, use 

the Accessibility 

Checker. 

Screen readers 

keep track of 

their location in 

a table by 

counting table 

cells.  

Screen readers 

also use header 

information to 

identify rows 

and columns. 

Avoid using 

tables 

Use table 

headers 

Use a larger font 

size (18pt or 

larger), sans serif 

fonts, and 

sufficient white 

space. 

To find potential issues 

related to fonts or 

white space, review 

your slides for areas 

that look crowded or 

illegible. 

People who 

have dyslexia 

describe seeing 

text merge or 

distort. 

Use an 

accessible 

presentatio

n template 

Use 

accessible 

font format 

and color 

Make videos 

accessible to 

people who have 

a vision or 

hearing 

disability. 

 
Subtitles typicall

y contain a 

transcription (or 

translation) of 

the dialogue. 

Closed 

captions typically 

also describe 

audio cues such 

as music or 

sound effects 

that occur off-

screen. 

Video 

description mean

s audio-narrated 

descriptions of a 

video's key 

Use 

captions, 

subtitles, 

and 

alternative 

audio 

tracks in 

videos 
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it 

visual elements. 

These 

descriptions are 

inserted into 

natural pauses in 

the program's 

dialogue. Video 

description 

makes videos 

more accessible 

to people who 
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Check accessibility while you work 
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The Accessibility Checker is a tool that reviews your content and flags 

accessibility issues it comes across. It explains why each issue might be a 

potential problem for someone with a disability. The Accessibility Checker 

also suggests how you can resolve the issues that appear. 

In PowerPoint, the Accessibility Checker runs automatically in the 

background when you're creating a presentation. If the Accessibility Checker 

detects accessibility issues, you will get a reminder in the status bar. 

To manually launch the Accessibility Checker, 

select Review > Check Accessibility. The Accessibility pane opens, and you 

can now review and fix accessibility issues. For more info, go to Improve 

accessibility with the Accessibility Checker. 
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Create accessible slides 

The following procedures describe how to make the slides in your 

PowerPoint presentations accessible. For more info, go to Video: Create 

slides with an accessible reading order and Video: Design slides for people 

with dyslexia. 

Use an accessible presentation template 

Use one of the accessible PowerPoint templates to make sure that your slide 

design, colors, contrast, and fonts are accessible for all audiences. They are 

also designed so that screen readers can more easily read the slide content. 

1. To find an accessible template, select File > New. 

2. In the Search for Online templates and themes text field, 

type accessible templates and press Enter. 

3. In the search results, select a suitable template. 

4. In the template preview, select Create. 
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Give every slide a title 

One simple step towards inclusivity is having a unique, descriptive title on 

each slide, even if it isn't visible. A person with a visual disability that uses a 

screen reader relies on the slide titles to know which slide is which. 
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Use the Accessibility ribbon to make sure every slide has a title. For 

instructions, go to Title a slide and expand the "Use the Accessibility ribbon 

to title a slide" section. 
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Hide a slide title 

You can position a title off the slide. That way, the slide has a title for 

accessibility, but you save space on the slide for other content. For 

instructions, go to Title a slide and expand the "Put a title on a slide, but 

make the title invisible" section. 

If you want all or many of your slide titles to be hidden, you can modify the 

slide master. For instructions, go to Title a slide and expand the 

"Systematically hide slide titles" section. 
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Restore a slide design 

If you've moved or edited a placeholder on a slide, you can reset the slide to 

its original design. All formatting (for example, fonts, colors, effects) go back 

to what has been assigned in the template. Restoring the design might also 

help you find title placeholders which need a unique title. 

1. To restore all placeholders for the selected slide, on the Home tab, in 

the Slides group, select Reset. 
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Set the reading order of slide contents 

Some people with visual disabilities use a screen reader to read the 

information on the slide. When you create slides, putting the objects in a 

logical reading order is crucial for screen reader users to understand the 

slide.  

Use the Accessibility Checker and the Reading Order pane to set the order 

in which the screen readers read the slide contents. When the screen reader 

reads the slide, it reads the objects in the order they are listed in 

the Reading Order pane.  

https://support.microsoft.com/en-us/office/title-a-slide-c5286802-495a-4b47-a8ae-212fb8a7dc74#OfficeVersion=Microsoft_365
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25?ui=en-us&rs=en-us&ad=us#bkmk_topwin
https://support.microsoft.com/en-us/office/title-a-slide-c5286802-495a-4b47-a8ae-212fb8a7dc74#OfficeVersion=Microsoft_365
https://support.microsoft.com/en-us/office/title-a-slide-c5286802-495a-4b47-a8ae-212fb8a7dc74#OfficeVersion=Microsoft_365
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25?ui=en-us&rs=en-us&ad=us#bkmk_topwin
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25?ui=en-us&rs=en-us&ad=us#bkmk_topwin


For the step-by-step instructions how to set the reading order, go to Make 

slides easier to read by using the Reading Order pane. 
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Use built-in slide designs for inclusive reading order, 

colors, and more 

PowerPoint has built-in, predesigned slide designs that contain placeholders 

for text, videos, pictures, and more. They also contain all the formatting, such 

as theme colors, fonts, and effects. To make sure that your slides are 

accessible, the built-in layouts are designed so that the reading order is the 

same for people who use assistive technologies such as screen readers and 

people who see. For more info, go to Video: Use accessible colors and styles 

in slides. 

1. On the View tab, select Normal. 

2. On the Design tab, do one or both of the following: 

▪ Expand the Themes gallery and select the slide layout that you 

want. PowerPoint automatically applies this layout to the 

presentation. 

▪ Select Design Ideas and select one of the predesigned 

designs. 
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Avoid using tables 

In general, avoid tables if possible and present the data another way, like 

paragraphs with headings. Tables with fixed width might prove difficult to 

read for people who use Magnifier, because such tables force the content to 

a specific size. This makes the font very small, which forces Magnifier users to 

scroll horizontally, especially on mobile devices. 

If you have to use tables, use the following guidelines to make sure your 

table is as accessible as possible: 

▪ Avoid fixed width tables. 

▪ Make sure the tables render properly on all devices, including phones 

and tablets. 

▪ If you have hyperlinks in your table, edit the link texts, so they make 

sense and don't break mid-sentence. 
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▪ Make sure the slide content is easily read with Magnifier. View it on 

a mobile device to make sure people won’t need to horizontally scroll 

the slide on a phone, for example. 

▪ Use table headers. 

▪ Test accessibility with Immersive Reader. 
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Use table headers 

Screen readers keep track of their location in a table by counting table cells. 

If a table is nested within another table or if a cell is merged or split, the 

screen reader loses count and can’t provide helpful information about the 

table after that point. Blank cells in a table could also mislead someone using 

a screen reader into thinking that there is nothing more in the table. Use a 

simple table structure for data only and specify column header information. 

Screen readers also use header information to identify rows and columns. 

To ensure that tables don't contain split cells, merged cells, or nested tables, 

use the Accessibility Checker. 

1. Place the cursor anywhere in a table. 

2. On the Table Design tab, in the Table Styles Options group, select 

the Header Row checkbox. 

3. Type your column headings. 
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Add alt text to visuals 

Alt text helps people who use screen readers to understand what’s important 

in the visuals in your slides. Visual content includes pictures, SmartArt 

graphics, shapes, groups, charts, embedded objects, ink, and videos. 

In alt text, briefly describe the image, its intent, and what is important about 

the image. Screen readers read the description to users who can’t see the 

content. 

Tip: To write a good alt text, make sure to convey the content and the purpose of the image in a concise and unambiguous manner. The alt 

text shouldn’t be longer than a short sentence or two—most of the time a few thoughtfully selected words will do. Do not repeat the 

surrounding textual content as alt text or use phrases referring to images, such as, "a graphic of" or "an image of." For more info on how to 

write alt text, go to Everything you need to know to write effective alt text. 

Avoid using text in images as the sole method of conveying important 

information. If you use images with text in them, repeat the text in the 
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slide. In alt text of such images, mention the existence of the text and its 

intent.  

PowerPoint for PC in Microsoft 365 automatically generates alt texts for 

photos, stock images, and the PowerPoint icons by using intelligent services 

in the cloud. Always check the autogenerated alt texts to make sure they 

convey the right message. If necessary, edit the text. For charts, SmartArt, 

screenshots, or shapes, you need to add the alt texts manually. 

For the step-by-step instructions on how to add or edit alt text, go to Add 

alternative text to a shape, picture, chart, SmartArt graphic, or other 

object and Video: Improve image accessibility in PowerPoint. 

Tips:  

▪ In the Alt Text pane, spelling errors are marked with a red squiggly line under the word. To correct the spelling, right-click the 

word and select from the suggested alternatives. 

▪ In the Alt Text pane, you can also select Generate a description for me to have Microsoft cloud-powered intelligent services 

create a description for you. You see the result in the alt text field. Remember to delete any comments PowerPoint added 

there, for example, "Description automatically generated." 

To find missing alternative text, use the Accessibility Checker. 

Note: For audio and video content, in addition to alt text, include closed captioning for people who are deaf or have limited hearing. 
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Create accessible hyperlink text and add 

ScreenTips 

People who use screen readers sometimes scan a list of links. Links should 

convey clear and accurate information about the destination. For example, 

avoid using link texts such as "Click here," "See this page," "Go here," or 

"Learn more." Instead include the full title of the destination page. You can 

also add ScreenTips that appear when your cursor hovers over text or images 

that include a hyperlink. 

Tip:  If the title on the hyperlink's destination page gives an accurate summary of what’s on the page, use it for the hyperlink text. For 

example, this hyperlink text matches the title on the destination page: Create more with Microsoft templates. 

For the step-by-step instructions on how to create hyperlinks and ScreenTips, 

go to Add a hyperlink to a slide. 
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Use accessible font format and color 
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An accessible font doesn't exclude or slow down the reading speed of 

anyone reading a slide, including people with low vision or reading disability 

or people who are blind. The right font improves the legibility and readability 

of the text in the presentation. 

For the step-by-step instructions on how to change fonts in PowerPoint go 

to Change the fonts in a presentation or Change the default font in 

PowerPoint. 
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Use accessible font format 

To reduce the reading load, select familiar sans serif fonts such as Arial or 

Calibri. Avoid using all capital letters and excessive italics or underlines. 

A person with a vision disability might miss out on the meaning conveyed by 

particular colors. For example, add an underline to color-coded hyperlink text 

so that people who are colorblind know that the text is linked even if they 

can’t see the color. For headings, consider adding bold or using a larger font. 
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Use accessible font color 

Here are some ideas to consider: 

▪ The text in your presentation should be readable in a high contrast 

mode. For example, use bright colors or high-contrast color schemes 

on opposite ends of the color spectrum. White and black schemes 

make it easier for people who are colorblind to distinguish text and 

shapes. 

▪ Use the predesigned Office Themes to make sure that your slide 

design is accessible. For instructions, go to Use an accessible 

presentation template or Use built-in slide designs for inclusive 

reading order, colors, and more. 

▪ Use the Accessibility Checker to analyze the presentation and find 

insufficient color contrast. It finds insufficient color contrast in text 

with or without highlights or hyperlinks in shapes, tables, or 

SmartArt with solid opaque colors. It does not find insufficient color 

contrast in other cases such as text in a transparent text box or 

placeholder on top of the slide background, or color contrast issues in 

non-textual content. 

https://support.microsoft.com/en-us/office/change-the-fonts-in-a-presentation-0109d7b7-4f3e-4d0a-b8a8-2604f21e977f#ID0EBBD=Windows
https://support.microsoft.com/en-us/office/change-the-default-font-in-powerpoint-8e93c947-c160-4310-8070-afea7da78c33
https://support.microsoft.com/en-us/office/change-the-default-font-in-powerpoint-8e93c947-c160-4310-8070-afea7da78c33
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25?ui=en-us&rs=en-us&ad=us#bkmk_topwin
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25?ui=en-us&rs=en-us&ad=us#bkmk_topwin
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25?ui=en-us&rs=en-us&ad=us#bkmk_templatewin
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25?ui=en-us&rs=en-us&ad=us#bkmk_templatewin
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25?ui=en-us&rs=en-us&ad=us#bkmk_designfororderwin
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25?ui=en-us&rs=en-us&ad=us#bkmk_designfororderwin
https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#PickTab=Windows


Top of Page 

Use captions, subtitles, and alternative 

audio tracks in videos 

PowerPoint supports the playback of video with multiple audio tracks. It also 

supports closed captions and subtitles that are embedded in video files. 

Currently, only PowerPoint for Windows supports insertion and playback of 

closed captions or subtitles that are stored in files separate from the video. 

For all other editions of PowerPoint (such as PowerPoint for macOS or the 

mobile editions), closed captions or subtitles must be encoded into the video 

before they are inserted into PowerPoint. 

Supported video formats for captions and subtitles vary depending on the 

operating system that you're using. Each operating system has settings to 

adjust how the closed captions or subtitles are displayed. For more 

information, go to Closed Caption file types supported by PowerPoint. 

Closed captions, subtitles, and alternative audio tracks are not preserved 

when you use the Compress Media or Optimize Media 

Compatibility features. Also, when turning your presentation into a video, 

closed captions, subtitles, or alternative audio tracks in the embedded videos 

are not included in the video that is saved. 

When you use the Save Media as command on a selected video, closed 

captions, subtitles, and multiple audio tracks embedded in the video are 

preserved in the video file that is saved. 

To make your PowerPoint presentations with videos accessible, ensure the 

following: 

▪ Videos include an audio track with video descriptions, if needed, for 

users who are blind or have low vision. 

▪ Videos that include dialogue also include closed captions, in-band 

closed captions, open captions, or subtitles in a supported format for 

users that are deaf or hard-of-hearing. 

For more information, refer to Add closed captions or subtitles to media in 

PowerPoint.  
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Save your presentation in a different 

format 

You can save your presentation in a format that can be easily read by a 

screen reader or be ported to a Braille reader. For instructions, go to Video: 

Save a presentation in a different format or Create accessible PDFs. Before 

converting a presentation into another format, make sure you run the 

Accessibility Checker and fix all reported issues. 
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Test accessibility with a screen reader 

When your presentation is ready and you've run the Accessibility Checker to 

make sure it is inclusive, you can try navigating the slides using a screen 

reader, for example, Narrator. Narrator comes with Windows, so there's no 

need to install anything. This is one additional way to spot issues in the 

navigation order, for example. 

1. Start the screen reader. For example, to start Narrator, press 

Ctrl+Windows logo key+Enter. 

2. Press F6 until the focus, the blue rectangle, is on the slide content 

area. 

3. Press the Tab key to navigate the elements within the slide and fix the 

navigation order if needed. To move the focus away from the slide 

content, press Esc or F6. 

4. Exit the screen reader. For example, to exit Narrator, 

press Ctrl+Windows logo key+Enter. 
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See also 

Rules for the Accessibility Checker 

Everything you need to know to write effective alt text 

Use a screen reader to attend a PowerPoint Live session in Microsoft Teams  

Make your Word documents accessible to people with disabilities 

Make your Excel documents accessible to people with disabilities 
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Closed Caption file types supported by PowerPoint 

Technical support for customers with 

disabilities 

Microsoft wants to provide the best possible experience for all our 

customers. If you have a disability or questions related to accessibility, please 

contact the Microsoft Disability Answer Desk for technical assistance. The 

Disability Answer Desk support team is trained in using many popular 

assistive technologies and can offer assistance in English, Spanish, French, 

and American Sign Language. Please go to the Microsoft Disability Answer 

Desk site to find out the contact details for your region. 

If you are a government, commercial, or enterprise user, please contact the 

enterprise Disability Answer Desk. 
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